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Temperature Multi-Input Device
1 Safety
1.1 Validity

The chapter “Safety” is valid as instruction manual.
Specific processes and instructions in this document require special precautions 
to guarantee the safety of the operating personnel.

1.2 Symbols used
This document contains information that you must read for your own personal 
safety and to avoid property damage. Depending on the hazard category, the 
warning signs are displayed in descending order as follows:
Safety-relevant symbols

Informative symbols

Action
This symbol indicates a paragraph with instructions.

1.3 System Operator and Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, 
and dismounting lies with the system operator.
Mounting, installation, commissioning, operation, maintenance and disassembly 
of any devices may only be carried out by trained, qualified personnel. The 
instruction manual must be read and understood.

Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt devices and any connected facilities or systems, 
or result in their complete failure.

Note!
This symbol brings important information to your attention.
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1.4 Pertinent Laws, Standards, Directives, and further Documentation
Laws, standards, or directives applicable to the intended use must be observed. 
In relation to hazardous areas, Directive 1999/92/EC must be observed.
The corresponding data sheets, declarations of conformity, EC-type-examination 
certificates, certificates and Control Drawings if applicable (see data sheet) are an 
integral part of this document. You can find this information under www.pepperl-
fuchs.com.
Due to constant revisions, documentation is subject to permanent change. Please 
refer only to the most up-to-date version, which can be found under www.pepperl-
fuchs.com.

1.5 Marking
The Temperature Multi-Input Devices are marked with:

The stars replace a combination of characters, depending on the product.
Electrical data see EC-type-examination certificate or data sheet.

1.6 Intended Use
The 8-channel Temperature Multi-Input Device measures temperature with 
resistance thermometers (RTD) or thermocouples (TC) via PROFIBUS PA. Each 
channel can be configured independently. 
The device complies with the PA profile 3.02: the device includes a 
physical block, an AI function block for each channel, and a transducer block 
belonging to each function block.

F2D0-TI-Ex8.PA.*:* RD0-TI-Ex8.PA.*
Pepperl + Fuchs Pepperl + Fuchs
68307 Mannheim, Germany 68307 Mannheim, Germany
F2D0-TI-Ex8.PA.*:* RD0-TI-Ex8.PA.*
PTB 03 ATEX 2237

 II 2 (1) G Ex ia [ia Ga] IIC T4 Gb ,
  II (1) G [Ex ia Ga] IIC ,
  II (1) D [Ex ia Da] IIIC ,
  II 3 G Ex ic IIC T4 Gc

PTB 03 ATEX 2237
 II 2 (1) G Ex ia [ia Ga] IIC T4 Gb ,
 II (1) G [Ex ia Ga] IIC ,
 II (1) D [Ex ia Da] IIIC ,
 II 3 G Ex ic IIC T4 Gc

PTB 03 ATEX 2238 X
 II 3 G Ex nA IIC T4 Gc

PTB 03 ATEX 2238 X
 II 3 G Ex nA IIC T4 Gc

0102
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The device may be installed in Zone 1.
The device may be installed in Zone 2.
The device may be installed in the safe area.
For applications in Zone 1, the type of protection is "Intrinsic Safety".
For Zone 2 applications, the type of protection can be Ex nA or Ex i.
Independent of the type of protection of the fieldbus, the sensor inputs remain 
intrinsically safe.
The device must only be operated in the ambient temperature range specified.
The devices are only approved for appropriate and intended use. Ignoring these 
instructions will void any warranty and absolve the manufacturer from any liability.

1.7 Improper Use
Protection of the operating personnel and the overall system is not ensured if the 
product is not being used according to its intended purpose.

1.8 Mounting and Installation
Prior to mounting, installation, and commissioning of the device you should make 
yourself familiar with the device and carefully read the instruction manual.
If devices have already been operated in general electrical systems, they may 
subsequently no longer be installed in electrical systems used in combination with 
hazardous areas.
The devices must be protected from electrostatic charge.
Installation Notes on Cables and Wires
If cables or wires are needed for installation, the following points must be 
considered/evaluated:
The dielectric strength of the insulation must be at least 500 V according to 
IEC/EN 60079-14. 
The permissible cross section of conductors must be considered.
The insulation stripping length must be considered.
The tightening torque for the screws of the terminal must be considered.
If you use stranded wires, crimp on wire end ferrules.
The cabling must not be strained and an adequate strain relief must be provided.
Unused conductors must be either connected to terminals or securely tied down 
and isolated.
7



Temperature Multi-Input Device
Safety
 20
13

-1
1

F2D0-Ti-Ex8.* - Installation Notes on IP Degree of Protection 
To ensure the IP degree of protection:

■ all seals must be undamaged and correctly fitted
■ all screws of the housing and its cover must be tightened with the 

appropriate torque
■ only cable of the appropriate size must be used in the cable glands
■ all cable glands must be tightened with the appropriate torque
■ all empty cable glands must be sealed with sealing plugs

F2D0-Ti-Ex8.* - Installation Notes on Cable Glands
If cable glands are needed for installation, the following points must be considered 
/ evaluated:

■ The cable glands used must be suitably certified for the application
■ The temperature range of the cable glands must be chosen according to 

the application.
■ The cable glands fitted must not reduce the IP rating.

Plastic cable glands must be protected against mechanical force.
1.8.1 Hazardous Area

Depending on the application, the device can be used as an Ex ia apparatus, an 
associated apparatus, or as an Ex nA apparatus. To ensure intrinsic safety, 
observe the following requirements. 
The installation instructions in accordance with IEC/EN 60079-14 must be 
observed.
The installation instructions in accordance with IEC/EN 60079-25 must be 
observed.
The respective peak values of the field device and the associated apparatus with 
regard to explosion protection should be considered when connecting intrinsically 
safe field devices with intrinsically safe circuits of associated apparatus 
(verification of intrinsic safety). Make sure to observe IEC/EN 60079-14 and 
IEC/EN 60079-25.
Circuits of intrinsically safe apparatus can be led into hazardous areas, whereby 
special attention must be paid to maintaining separation distances to all non-
intrinsically safe circuits according to the requirements in IEC/EN 60079-14.
Intrinsically Safe Apparatus (Ex i)
The device may be used as intrinsically safe apparatus.
Depending on where the apparatus is located, observe the following instructions:

■ See chapter 1.8.2
All separation distances between two adjacent intrinsically safe circuits need to be 
observed in accordance with IEC/EN 60079-14.
8
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If devices have already been operated in general electrical systems, they may 
subsequently no longer be installed in electrical systems used in combination with 
hazardous areas.
Associated Apparatus
The device may be used as associated apparatus.
Depending on where the apparatus is located, observe the following instructions:

■ See chapter 1.8.2
Intrinsically safe circuits of associated apparatus (installed in safe areas) can be 
led into hazardous areas, whereby special attention must be paid to maintain 
separation distances to all non-intrinsically safe circuits according to the 
requirements in IEC/EN 60079-14.
If the device is supplied by a non-intrinsically safe fieldbus, the separation wall 
must be applied to maintain the separation distance requirements according to 
IEC/EN 60079-11.
Non-Arcing Apparatus (Ex nA)
The device may be used as non-sparking apparatus.
Depending on where the apparatus is located, observe the following instructions:

■ See chapter 1.8.3
If the device is supplied by a non-intrinsically safe fieldbus, the separation wall 
must be applied to maintain the separation distance requirements according to 
IEC/EN 60079-11.
RD0-TI-Ex8.* with surrounding enclosure
The devices may only be installed and operated in Zone 2 if they have been 
mounted in a surrounding enclosure with degree of protection IP54 according to 
IEC/EN 60529. The surrounding enclosure must have a declaration of conformity 
according to 94/9/EC for at least category 3G.

1.8.2 Instructions for Zone 1
The device may be operated in Zone 1.
The installation instructions in accordance with IEC/EN 60079-14 must be 
observed.
The installation instructions in accordance with IEC/EN 60079-25 must be 
observed.
The device is designed for use in intrinsically safe fieldbus systems according to 
FISCO or Entity.
The respective peak values of the field device and the associated apparatus with 
regard to explosion protection should be considered when connecting intrinsically 
safe field devices with intrinsically safe circuits of associated apparatus 
(verification of intrinsic safety). Make sure to observe IEC/EN 60079-14 and 
IEC/EN 60079-25.
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1.8.3 Instructions for Zone 2 and Safe Areas
The device may be installed in Zone 2.
For Zone 2 applications, the type of protection can be Ex nA or Ex i.
All separation distances between intrinsically safe and non-intrinsically safe 
circuits must be observed in accordance with IEC/EN 60079-14.
The respective peak values of the field device and the associated apparatus with 
regard to explosion protection should be considered when connecting intrinsically 
safe field devices with intrinsically safe circuits of associated apparatus 
(verification of intrinsic safety). Make sure to observe IEC/EN 60079-14 and 
IEC/EN 60079-25.
If the device is supplied by a non-intrinsically safe fieldbus, the separation wall 
must be applied to maintain the separation distance requirements according to 
IEC/EN 60079-11.
Connection or disconnection of energized non-intrinsically safe circuits is only 
permitted in the absence of a hazardous atmosphere.

1.9 Repair and Maintenance
The devices must not be repaired, changed or manipulated. If there is a defect, 
the product must always be replaced with an original device.

1.10 Delivery, Transport and Storage
Check the packaging and contents for damage. 
Check if you have received every item and if the items received are the ones you 
ordered.
Keep the original packaging. Always store and transport the device in the original 
packaging.
Always store the device in a clean and dry environment. The permitted storage 
temperature (see data sheet) must be considered.

1.11 Disposal
Disposing of devices, packaging material, and possibly contained batteries must 
be in compliance with the applicable laws and guidelines of the respective 
country.
10
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Temperature Multi-Input Device
2 Product Specifications
2.1 Overview and Application

The Temperature Multi-Input Device offers universal temperature measurement, 
voltage, and resistance input.
This manual describes the following Temperature Multi-Input Devices:

■ F2D0-TI-Ex8.*.*:* in a fieldbus housing for panel mounting 
■ RD0-TI-Ex8.*.* for mounting on a 35 mm DIN rail in accordance with 

EN 50022

Figure 2.1 Installation options for the Temperature Multi-Input Device in the hazardous 
area

For details concerning the requirements of the different installation options, see 
chapter 1.8.
Observe the EC-type-examination certificate or the statement of conformity. Pay 
particular attention to any "special conditions" that may be indicated.

Hazardous Area Installation Options

Zone 2

Zone 0

Zone 1

Safe Area

PI
*D0-TI-Ex8.*

PI
*D0-TI-Ex8.*

FB
11



Temperature Multi-Input Device
Product Specifications
 20
13

-1
1

2.2 Component Identity
The following section shows the dimensions, the inside connections, and the 
options of the device.

1. Notch for fixing the Temperature Multi-Input Device housing with M6 screw 
2. Grounding point for connecting the Temperature Multi-Input Device to earth 

with M4 screw
3. Cable gland for the fieldbus IN cable. For outside dimensions, see data 

sheet.
4. 8 cables glands for inputs, wrench size AF 20. For outside dimensions, see 

data sheet.
X: Height depending on cable gland, see data sheet.
All dimensions in millimeters (mm).

F2D0-TI-Ex8.* housing and dimensions
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1. Service interface (covered)
2. Status LEDs for channel fault indication
3. Status LED for communication 
4. Status LED for power
5. Dip switches for configuration: 
6. Separation wall: Used if Temperature Multi-Input Device is supplied by a 

non-intrinsically safe fieldbus.
7. DIN mounting rail
8. Mounting on DIN rail

All dimensions in millimeters (mm).
2.3 Technical Data

RD0-TI-Ex8.PA

RD0-TI-Ex8.* components and dimensions
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Technical data
Fieldbus interface
Fieldbus type PROFIBUS PA
Firmware update via separate plug connection
FDE (Fault Disconnect Equipment) 6.7 mA
Polarity not polarity sensitive
Rated voltage 9 ... 32 V
Rated current max. 23 mA
PROFIBUS PA
Profile 3.02
Indicators/operating means
LED PWR green: on, bus voltage existent
13
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LED COM ERR red: continuous lightning: hardware error; 2 
Hz flashing: no bus activities or bus fault; 
off: no error

LED CHANNEL ERROR red: 2 Hz flashing: lead breakage, 
overrange; off: no error

Input
Number 8
Sensor types see data sheet
Grounding grounding of thermoelements possible
Error detection lead breakage, wiring error, hardware 

device error
Common mode voltage Input to Input 600 Vpeak

Transfer characteristics
Deviation
Cold junction compensation ± 0.5 °C (32.9 °F)
Resolution/accuracy see data sheet
Influence of ambient temperature see data sheet
Linearization T/C input 0.1°C RTD input 0.03°C
Internal measurement cycle for all sensor types max. 1 s
Electrical isolation
Fieldbus/inputs safe galvanic isolation acc. to EN 60079-

11, voltage peak value 375 V
Directive conformity
Electromagnetic compatibility
Directive 2004/108/EC EN 61326-1:2006
Standard conformity
Electrical isolation EN 60079-11
Electromagnetic compatibility NE 21:2011
Protection degree IEC 60529
Fieldbus standard IEC 61158-2
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Ambient conditions
Ambient temperature -40 ... 70 °C (-40 ... 158 °F) hazardous area 

-40 ... 85 °C (-40 ... 185 °F) safe area
Storage temperature -40 ... 85 °C (-40 ... 185 °F)
Relative humidity  95 % non-condensing
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3
Mechanical specifications

Technical data
14



Temperature Multi-Input Device
Product Specifications

 20
13

-1
1

Connection type plug-in terminals , spring terminal and 
screw terminal

Core cross-section
Bus up to 2.5 mm2

Inputs up to 2.5 mm2

Housing material Polycarbonate
Protection degree IP20
Mass 360 g
Mounting mounting on DIN rail in cabinet
Data for application in connection with Ex-areas
EC-Type Examination Certificate PTB 03 ATEX 2237
Group, category, type of protection, 
temperature class  II 2 (1) G Ex ia [ia Ga] IIC T4 Gb ,

 II (1) G [Ex ia Ga] IIC ,
 II (1) D [Ex ia Da] IIIC ,
 II 3 G Ex ic IIC T4 Gc

Bus FISCO see EC-Type Examination 
Certificate

Voltage Ui 24 V
Inputs see EC-Type Examination Certificate
Statement of conformity PTB 03 ATEX 2238 X
Group, category, type of protection, 
temperature class  II 3 G Ex nA IIC T4 Gc
Electrical isolation
Bus see Statement of Conformity
Input see EC-Type Examination Certificate
Directive conformity
Directive 94/9/EC EN 60079-0:2012 , EN 60079-11:2012 , 

EN 60079-15:2010
International approvals
IECEx approval IECEx PTB 05.0001 , IECEx PTB 

05.0002X
Approved for Ex ia [ia Ga] IIC T4 Gb , [Ex ia Ga] IIC , [Ex 

ia Da] IIIC , Ex ic IIC T4 Gc , Ex nA IIC T4 
Gc

Certificates and approvals
Marine approval pending

Technical data
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F2D0-TI-Ex8.PA

General information
Supplementary information EC-Type Examination Certificate, 

Statement of Conformity, Declaration of 
Conformity, Attestation of Conformity and 
instructions have to be observed where 
applicable. For information see 
www.pepperl-fuchs.com.

Technical Data
General specifications
Electronic component Temperature Multi-Input Device RD0-TI-

Ex8.PA* For technical data on installed 
electronic component see data sheet.

Standard conformity
Electrical isolation EN 60079-11
Electromagnetic compatibility NE 21:2011
Protection degree IEC 60529
Fieldbus standard IEC 61158-2
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Ambient conditions
Ambient temperature see data sheet
Storage temperature -40 ... 85 °C (-40 ... 185 °F)
Relative humidity  95 % non-condensing
Shock resistance 15 g , 11 ms
Vibration resistance 10 g , 10 ... 150 Hz
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3
Mechanical specifications
Connection type plug-in terminals , spring terminal and 

screw terminal
Core cross-section
Bus up to 2.5 mm2

Inputs up to 2.5 mm2

Cable diameter see data sheet
Cable gland sensor inputs M16, fieldbus M20
Housing material ALSI12 (Cu) DIN1725 (Si 1.2%), anodized
Protection degree IP66
Mass 1800 g
Mounting panel mounting

Technical data
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Data for application in connection with Ex-areas
EC-Type Examination Certificate PTB 03 ATEX 2237
Group, category, type of protection, 
temperature class  II 2 (1) G Ex ia [ia Ga] IIC T4 Gb ,

 II (1) G [Ex ia Ga] IIC ,
 II (1) D [Ex ia Da] IIIC ,
 II 3 G Ex ic IIC T4 Gc

Bus FISCO see EC-Type Examination 
Certificate

Inputs see EC-Type Examination Certificate
Statement of conformity PTB 03 ATEX 2238 X
Group, category, type of protection, 
temperature class  II 3 G Ex nA IIC T4 Gc
Electrical isolation
Bus see Statement of Conformity
Input see EC-Type Examination Certificate
Directive conformity
Directive 94/9/EC EN 60079-0:2012 , EN 60079-11:2012 , 

EN 60079-15:2010
International approvals
IECEx approval IECEx PTB 05.0001 , IECEx PTB 

05.0002X
Approved for Ex ia [ia Ga] IIC T4 Gb , [Ex ia Ga] IIC , [Ex 

ia Da] IIIC , Ex ic IIC T4 Gc , Ex nA IIC T4 
Gc

Certificates and approvals
Marine approval pending
General information
Supplementary information EC-Type Examination Certificate, 

Statement of Conformity, Declaration of 
Conformity, Attestation of Conformity and 
instructions have to be observed where 
applicable. For information see 
www.pepperl-fuchs.com.

Technical Data
17



Temperature Multi-Input Device
Installation and Commissioning

Temperature Multi-Input Device
 20
13

-1
1

3 Installation and Commissioning
In the following section you find information on how to install and commission the 
Temperature Multi-Input Device in your fieldbus topology.

3.1 Mounting and Dismounting
Mounting/Dismounting F2D0-TI-Ex8.*
F2D0-TI-Ex8.* is designed for panel (wall) mounting. 

■ Select mounting material that is suitable for the sub-surface (the wall). 
■ Ensure that the mounting material guarantees secure fastening.
■ To attach the device: use 2 fixing screws with a diameter of 6 mm. 
■ To dismount the device: Undo the fixing screws and take the device off the 

wall.
Mounting/Dismounting RD0-TI-Ex8.*
RD0-TI-Ex8.* is designed for mounting on a 35 mm DIN rail in accordance with 
EN 50022. 

Note!
Before performing any work: Read the section on Safety, see chapter 1, especially 
all sections that are relevant for your application.
18
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Ensure that the device is firmly fixed on the DIN rail.
To dismount the device: Take off the device in reverse order.
RD0-TI-Ex8.* Installations 
Depending on the application, the RD0-TI-Ex8.* must be mounted in a suitable 
environment. 
If mounted in Zone 2 for an Ex nA application, the environment must ensure the 
following degree of protection: 

■ IP54 in accordance with IEC 60529 for hazardous area Zone 2
3.1.1 Using the Separation Wall

If the device is supplied by a non-intrinsically safe fieldbus, the separation wall 
must be applied to maintain the separation distance requirements according to 
IEC/EN 60079-11.
The device is delivered with a removable separation wall. The separation wall 
separates the fieldbus terminals from the terminals of the sensor inputs. This way 
it ensures the clearance requirements of IEC/EN 60079-11 between intrinsically 
safe and non-intrinsically safe signals.
19
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3.2 Hardware Installation
3.2.1 Temperature Multi-Input Device Cable and Connection Information

Sensors can be connected to either of the following 2 types of terminals as pre-
engineering options:

■ Spring terminals
■ Screw terminals

Adhere to the following information when connecting cables to terminals:
■ Insulating length of wires: 9 mm
■ Wire cross-section: 0.2 mm² ... 2.5 mm² or AWG 24 ... 14
■ When using a fine wire cable: Protect the ends of the leads, e.g., with core 

cable ends
■ Screw terminals tightening torque: 0.4... 0.5 Nm
■ Insulation voltage between the fieldbus line and the shield for intrinsically 

safe segments:  500 V
Parameterization interface: Service interface.   see image on page 13. 
Parameterization tasks may be carried out via the Service interface only by trained 
specialists authorized by Pepperl+Fuchs. 
20
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The Service interface fulfills the type of protection EEx ia IIC/IIB, respectively 
EEx ib IIC/IIB with the following values: 

■ UO = 7.2 V 
■ IO = 29.1 mA
■ PO = 52.38 mW
■ Li = 0
■ Ci = 0 
■ Characteristic curve: linear
■ Only for connection of intrinsically safe circuits
■ Ui = 5 V

3.2.2 F2D0-TI-Ex8.* Housing: Ensuring the Degree of Protection
The following section contains information concerning the installation and sealing 
of the cable glands and the housing cover.
Installing cable glands
When installing cable glands, observe the following:

■ Only insert permanently laid cables and wires into the cable glands. 
■ Ensure that the cables laid do not execute any strain on the cable glands. 
■ For permissible cable diameters, refer to the respective data sheet. 
■ Use an appropriate strain-relief clamp, e.g., a suitable cable clamp. 
■ Seal unused cable glands with a suitable plug or replace them with  

appropriate screw plugs. Observe the required degree of protection IP66. 
For a choice of stop plugs and screw plugs, refer to the respective 
datasheets. 
Note that the ambient temperature range can be restricted by the stop plug.

The following table with tightening torques offers an approximate guideline:

Note!
Careful when tightening cap nuts!

■ The cap nuts must be securely tightened. Tightening the cap nuts too much 
or not enough both can affect the degree of protection.

■ The tightening torques of cap nuts vary, depending on the cable type used. 
For exact details refer to the documentation of your cable manufacturer.

Type Size Cap nut Counterpart
F2D0-TI-
Ex8.*.*:*.CG

M16 2.5 Nm 3.75 Nm
M20 2.5 Nm 3.75 Nm

F2D0-TI-
Ex8.*.*:*.CGB

M16 6 Nm 6 Nm
M20 10 Nm 10 Nm

F2D0-TI-
Ex8.*.*:*.CGS

M16 6 Nm 6 Nm
M20 10 Nm 10 Nm
21
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To connectorize cables using F*D0-TI-Ex8.*.CG cable glands
1. Strip the insulation of the cable up to about 120 mm.

2. Loosen the cap nut and the seals from the Temperature Multi-Input Device. 
Depending on the application, slip Seal 1 & Seal 2 or only the obligatory 
Seal 2 over the cable as shown:

1. Seal 1, used in the following instance: Type: M20 x 1.5, Terminal area: 5-8 
mm

2. Seal 2, obligatory
3. Move the required seal(s) over the cable until after the last seal about 5 mm 

insulation protrude before the stripped wire begins:

4. Insert the cable with the seals into the cable gland of the Temperature Multi-
Input Device and tighten the cap nut.
The tightening torques of cap nuts vary depending on the cable type used. 
Tightening torques (approx.): 
- Cap nut 2.5 Nm
- Counterpart 3.75 Nm 

2 1
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To connectorize cables using F*D0-TI-Ex8.*.CGB and F*D0-TI-
Ex8.*.CGS cable glands
1. Strip the insulation of the cable up to about 120 mm.

2. Loosen the cap nut from the Temperature Multi-Input Device. 

3. Remove the inner plastic piece and slip it onto the cable: move it far enough 
over the cable, so it completely surrounds the cable insulation. 
Ensure that no cable insulation protrudes behind the inner plastic piece.
23



Temperature Multi-Input Device
Installation and Commissioning
 20
13

-1
1

1. Inner plastic piece
2. O-ring

4. Invert the cable shield over the inside plastic piece and shorten it to a length 
of 3-4 mm behind the O-ring.

1. O-ring
2. Inverted cable shield

5. Insert the cable wires with the inner plastic piece into the counterpart of the 
cable gland.

6. Tighten the cap nut.
The tightening torques of cap nuts vary, depending on the cable type used. 
Tightening torques (approx.): 
- Cap nut 4.17 Nm
- Counterpart 6.25 Nm

1 2

1 2

3-4 mm
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Fixing the housing cover
 Before closing the housing cover: Visually inspect the housing for any visible 
signs of damage on the cover seal. If damaged, replace the seal with an original 
seal wear part. 
Tightening torque for the screws of the housing cover: 2.5 Nm 

3.2.3 Grounding and Shielding

Potential Equalization for Devices in F2 Metal Housings
For devices in metal housings in Zone 1 hazardous areas, a suitable potential 
equalization in accordance with IEC/EN 60079 is required. Therefore, the device 
is designed as follows:

■ The shield (terminal S) of the intrinsically safe segment is internally 
connected to the F2 housing. 

■ The housing has a grounding point with a grounding screw. The grounding 
connection must be secured against loosening and corrosion, e. g., by 
using tinned cable plates.

Shielding the Electronic Component R in Intrinsically Safe Segments
The shield (terminal S) of the intrinsically safe segment is internally connected to 
the DIN mounting rail. 

Note!
Electromagnetic Compatibility and Grounding
If the shield of the fieldbus transmission line is grounded for EMC reasons, the 
following guideline must always be observed:

■ PROFIBUS PA User and Installation Guideline

Note!
Ensure potential equalization of F2 Metal Housings
Ensure that the housing is connected properly to the potential equalization.

Note!
Ensure shielding of the electronic component R
Ensure that the DIN mounting rail is connected to the cabinet and the cabinet itself 
is connected to the potential equalization.
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3.2.4 Electrical Connection
Sensor types connecting to Temperature Multi-Input Devices

Figure 3.1 RTD, 2-wire technology

Figure 3.2 RTD, 3-wire technology

Figure 3.3 RTD, 4-wire technology

Figure 3.4 Millivolt

Figure 3.5 Thermocouple

+ -
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H L
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3.2.5 Dip Switch Settings
The device has 8 DIP switches. 

■ Dip switch 1 ... 7: Bus address setting
■ Dip switch 8: Write lock ON/OFF

Dip switch 1-7 "Bus Address": 
In order to assign a fixed PROFIBUS address to the device use the dip switches 
1 ... 7. 
Dip switch 8 "Write lock ON/OFF": 
In order to enable/disable parameterization of the device via the bus use dip 
switch 8.

3.3 Write Protection Settings
To protect the parameters from modification you can use write protection. 
Write protection has the following effects: 

■ Acyclic write access is blocked 
Activate write protection in either of the following ways: 

■ Hardware write protection: Use DIP switch 8 on the device (see below).
■ Software write protection: Activate the respective parameter in the DTM 

software. See chapter 4.
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Figure 3.6 Dip switch 8 to activate the hardware write protection

Both write protection methods work the same way, regardless of which one is 
activated. 

3.4 Address Settings
Assigning a PROFIBUS Address
In order to assign an address to the Temperature Multi-Input Device, use the DIP 
switches 1 ... 7.

Figure 3.7 DIP switches to set the PROFIBUS address on the device

After modifying the address DIP switches, the device must be rebooted to use the 
new setting. Either disconnect the device from the fieldbus and then reconnect it, 
or restart the device via the DTM.
The address can be assigned in 2 ways:

1. Hardware address setting:Use the DIP switches to set the hardware ad-
dress in the range of 0 ... 125 as PROFIBUS address. Any attempt to 
change this address via the fieldbus is automatically denied. 
To change an hardware address setting, use the DIP switches.

Activating Write Protection via the Dip Switch

Position ON = Active
Position OFF = Not active (default setting)
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2. Software address setting: To enable software address setting, set the DIP 
switches either to 126 or 127. For details on how to change the address via 
the fieldbus, refer to the documentation of the respective COM DTM. 
When the address is changed, the device automatically reboots, using the 
new address afterwards. 

3.5 PROFIBUS Ident Number Setting
In order to select the ident number in the DTM software, use the parameter 
"PROFIBUS Ident Number". For details, see chapter 4.1.1.
Manufacturer-Specific PROFIBUS Ident Number
A manufacturer-specific PROFIBUS ident number is available for the Temperature 
Multi-Unit by Pepperl+Fuchs. 

■ Manufacturer-specific PROFIBUS ident number: 0E89h
Profile-Specific PROFIBUS Ident Number
A profile-specific PROFIBUS ident number is available for the Temperature Multi-
Unit by Pepperl+Fuchs. 

■ Profile-specific PROFIBUS ident number: 9707h, for 8x analog input

3.6 Requirements for Commissioning
Before commissioning the Temperature Multi-Input Device (TM-I), ensure that the 
following requirements are met: 

■ For acyclic communication/parameterization: A suitable FDT frame is in 
place in order parameterize the TM-I via a PROFIBUS DP master. The DTM 
needed to run in the FDT frame can be downloaded from Internet under 
www.pepperl-fuchs.com. Refer to the release notes of the DTM for 
information on the frameworks that are supported. The release note are 
included in the FieldConnex® DTM package. For more information, see 
chapter 3.8.

Note!
■ By default, the Temperature Multi-Input Device is delivered with the 

address set to 126. This enables the modification of the address via the 
bus.

■ An address set via the bus remains active, even if the device has been 
temporarily disconnected from the bus.

■ If an address in the range of 1 ... 127 is set via the dip switches, this 
address overrules an address previously set via the bus.

Note!
Automatic Mode
By default, the device is set to "Automatic" mode: In the process of establishing 
cyclic communication, the device queries if either of the following 2 ident numbers 
that support the device is set. If this is the case, the device automatically uses that 
number. 
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■ For cyclic communication/configuration: A process control system (PCS) is 
prepared to configure cyclic user data exchange via a PROFIBUS DP 
Master Class I. 

■ The PROFIBUS master is connected to a PROFIBUS DP segment. No DP 
slaves need to be available at the DP segment.

■ A PROFIBUS PA segment is connected via a Segment Coupler.
■ The bus terminations at both ends of the PROFIBUS PA segment are 

mounted or switched ON.
■ The correct bus parameters for the Segment Coupler of the PROFIBUS DP 

are set via the DP master. See operating instructions of Segment Coupler. 
■ A Temperature Multi-Input Device is installed at the PROFIBUS PA 

segment as shown in see chapter 2.1.
3.7 Parameterization and Configuration Procedure

Use the FDT frame with the DTM to parameterize the device. Parameterization is 
an "acyclic" communication, i.e., read/write data is read from or stored on the 
device as needed. This also means that once set in the DTM, the parameters are 
kept even if the device is put into operation at a later point.
Use the following checklist when commissioning the device. Skip those steps you 
have already completed. For detailed information on how to proceed, refer to the 
chapters mentioned. 
Parameterization (hardware and software): 

1. Set a fixed valid PROFIBUS address 0 ... 125 via the DIP switch of the de-
vice or set the address 126 (default setting) for assignment of the address 
via the configuration or parameterization tool. See chapter 3.4.

2. Set the parameters for the devices in your project, e. g., PROFIBUS ident 
number, description parameters (see chapter 3.5, see chapter 4.1.1).

3. Set channel-specific parameters. See chapter 4.2. For a list of all parame-
ters, See chapter 7. 

4. If needed, activate the hardware or software write protection to protect the 
parameters from overwriting. See chapter 3.3. 

Configuration:
1. Log on to the DP master.
2. Select the GSD file to be used (manufacturer-specific, profile-specific). See 

chapter 3.5.
If necessary, install the respective GSD file. 

3.8 DTM Software Installation and Commissioning
For details on the system requirements for installation, commissioning, and 
operation of the software, refer to the release notes of the DTM. The release notes 
are available on the Internet under www.pepperl-fuchs.com. 
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To install the DTM package with the FDT frame application PACTwareTM 
(example)
To install the DTM package on your system, proceed as follows: 
1. Install the Pepperl+Fuchs FieldConnex DTM package. For more information, 

refer to the Readme file in the FieldConnex® DTM Collection.
2. Start the PACTwareTM program.

Make sure that all PACTwareTM projects are closed. 
3. To open the Device Catalog, press F3.
4. To update the device catalog click on the button Update device catalog.

 The request Create new PACTware device catalog appears. 
5. Confirm the question with Yes.

 The DTM is installed and ready for operation. 
To create a project 
To create the project, proceed as follows: 
1. Start PACTwareTM.

Make sure the latest DTM version is installed and that the device catalog is up-
dated.

2. To open a project or create a new project select:
File > Open or
File > New.

3. Open the device catalog: 
View > Device Catalog or 
press F3. 

4. Open the respective "Vendor" menu item.
5. Choose Driver >  and the respective PROFIBUS COM DTM.
6. Drag and drop the PROFIBUS COM DTM driver to your project window under 

Host PC.
7. In the device catalog, open the "Vendor" menu item Pepperl+Fuchs GmbH.
8. Choose Device > *D0-TI-Ex8.PA.*.
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9. Drag and drop the DTM D0-TI-Ex8.PA.* to your project window under the 
PROFIBUS COM DTM driver.

 Your project should now look like this: 

Figure 3.8 DTM project

3.9 DTM Dialogs
The DTM *D0-TI-Ex8.PA.* features the following dialogs to parameterize and 
monitor the Temperature Multi-Input Device:

■ Parameterization
■ Online parameterization
■ Measured value
■ Diagnosis
■ Simulation (Force)

Parameterization Process of the DTM
The following flowchart shows how parameterization is organized, when using the 
DTM.

Figure 3.9 Parameterization flowchart
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Read from Device
Settings made in the online parameter set are not automatically transferred to the 
offline parameter set.
The function Read from Device is used to upload data from the device into the 
offline parameter set.
To read from device
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Read from Device.
Store to Device
If a device is replaced with a new device, the parameters that where used last can 
be downloaded to the device. 
The function Store to Device is used to download parameters from the DTM to 
the device.  
To store to device
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Store to Device.

3.9.1 Online Dialogs
Online dialogs show the currently set parameters stored on the device. 
Connecting to the Device
In order to use the online dialogs, you need to connect to the device first.
To connect the *D0-TI-Ex8.PA.* DTM with the device
Make sure all settings are correct, e. g., the device address, etc.
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Connect.

 The Plug icon in the menu bar indicates that device is connected, i. e., 
online. 

Online Parameterization
Setting parameters in the online dialog directly affects device parameters. Entries 
or changes are immediately written to the device, as soon as affirmed with the 
Return key.
To open the online parameterization dialog
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Parameters > Online Parameterization.
Measured Value
The dialog issues a list of the currently measured values at any time.
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To open the measured value dialog
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Measured Value.
Diagnosis
The dialog offers a current overall summary of the diagnostic state of the device 
and each channel.
To open the diagnosis dialog
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.* 
2. Select Diagnosis.
Simulation (Force)
The dialog can be used to simulate parameter settings for the device in use or 
manually set OUT value and status for the device. 
This way, you can validate settings for your application, before using them in live 
operation. In the course of commissioning you can check what parameters are 
required to achieve specific OUT values. You can also use the manual OUT value 
setting to force an OUT value, e. g., in case of a sensor failure.
To open the simulation dialog
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Simulation.

3.9.2 Offline Dialogs
The offline dialogs show the parameters currently stored in the DTM parameter 
set of the FDT project. 
Offline Parameterization
Setting parameters locally in the offline dialog does not directly affect 
communication or the device. Once all settings are made, data can be written to 
the device. Current parameters can also be read in from the device, processed, 
and saved.
To open the offline parameterization
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Parameters > Parameterization.
Print
This offline dialog is a summary report that contains all offline parameter settings.
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To print offline information
1. To open the context menu, right-click in the project on *D0-TI-Ex8.PA.*
2. Select Print.
3. In the footer of the print preview window click Print.

 The printer selection menu appears.
4. Select your printer and confirm the print job.

3.9.3 DTM User Interface
The DTM user interface looks like this:

Figure 3.10 DTM user interface (online parameterization)
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3.9.4 DTM Structural Diagram
The following diagrams show all device-specific and channel-specific parameters 
the DTM offers for parameterization. 

Figure 3.11 DTM menu structure: Device-specific
Parameters in square brackets [   ]: Online parameters only.
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Figure 3.12 DTM menu structure: Channel-specific
Parameters in square brackets [   ]: Online parameters only.
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4 Device Parameterization
During acyclic data exchange, service data is transmitted, e. g., device 
parameters or diagnostic information. A number of parameters of the Temperature 
Multi-Input Device can be adjusted acyclically, using both DIP switches and the 
*D0-TI-Ex8.PA.* DTM. For dip switch parameterization, see chapter 3.2.5
This chapter describes the parameterization of the device with the *D0-TI-
Ex8.PA.* DTM. 
The device supports both diagnosis types: “condensed diagnosis” and “classic 
diagnosis” according to the PA Profile 3.02. See chapter 4.3.

Commands in the online mode
The following DTM menu commands can be set or are displayed additionally in 
the online mode.

■ Activate Write Lock: To activate the write lock, in the DTM menu bar 
select Device actions > Activate write lock.

Figure 4.1 Online parameterization menu item Activate write lock

■ Write Lock Active: Information banner in the DTM menu bar, signaling that 
the write protection is enabled. The banner includes the option Unlock 
device. 

Note!
Diagnostic Information Display
The *D0-TI-Ex8.PA.* DTM always displays diagnostic information in condensed 
mode, independent of which type is used for cyclic communication.
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Figure 4.2 Information banner Write lock active

■ Select Ident Number ...To choose between the profile-specific and the 
manufacturer-specific ident number, in the DTM menu bar select Device 
actions > Select Ident Number ....
Upon choosing the ident number, the device will be automatically restarted.
Note: If you have changed parameters without applying the changes, 
PACTwareTM asks you to apply/revert your changes first and repeat this 
command after that. 

Figure 4.3 Online dialog menu item Select ident number

■ Restart device: To restart the device, in the DTM menu bar select Device 
actions > Restart device.
The device will be immediately restarted.
Note: If you have changed parameters without applying the changes, 
PACTwareTM asks you to apply/revert your changes first and repeat this 
command after that. 
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Figure 4.4 Online dialog menu item Restart device

■ Reset bus address: To reset the bus address of the device to the default 
126, in the DTM menu bar select Device actions > Reset bus address.
The device will immediately return to the default address 126. The device 
automatically reboots and the changes become effective.
Note: If you have changed parameters without applying the changes, 
PACTwareTM asks you to apply/revert your changes first and repeat this 
command after that. 

Figure 4.5 Online dialog menu item Reset bus address

■ Reset to factory defaults: To reset the device information to the factory 
default, in the DTM menu bar select Device actions > Reset to factory 
defaults.


The device will immediately return to the factory defaults. The device 
automatically reboots and the changes become effective.
Note: If you have changed parameters without applying the changes, 
PACTwareTM asks you to apply/revert your changes first and repeat this 
command after that. 
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Figure 4.6 Online dialog menu item Reset to factory defaults

4.1 Device-Specific Parameters
In order to describe the device, several free value or text field parameters are 
available in the DTM software. 

4.1.1 Tab "Device Information"

Figure 4.7 Tab device information offline
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The tab "Device Information" contains the following information and parameters:
Section "General": 

■ Tag: *.D0-TI-Ex8.PA*: Free text field, enter a description of the device. 
■ Device ID: *.D0-TI-Ex8.PA*: Read-only, manufacturer-specific description 

of the device.
■ Manufacturer: Pepperl+Fuchs: Read-only, identification of the 

manufacturer of the device.
Additional general parameters in the online mode
In the online mode, the following read-only information is displayed.
Use this data as additional diagnostic information when contacting 
Pepperl+Fuchs.

■ Static revision: Incremental modification counter for counting each 
modification of a parameter to document the status of modification of 
parameterization. 
This parameter counts all changes in all device-specific online parameters. 

■ Software revision: Software revision number
■ Hardware revision: Hardware revision number
■ Serial number: Serial number of the device

Section "Identification information": 
■ Strategy: Free value field, enter value to use for configuration or 

diagnostics as a code key for sorting or summarizing diagnostic 
information. 

■ Alert key: Free value field, enter any value for sorting alarms or events that 
have been generated. The value can contain the identification number of 
the plant unit. It helps to identify the location (plant unit) of an event. 

■ Description: Free text field, enter any information to describe the device as 
a measuring point in the application. 

■ Message: Free text field, enter any information to describe the device in 
the application or plant. 

■ Installation date: Free text field, enter the installation date of the device in 
the plant.

Section "Configuration options":
■ ASIC-REJECTION: Filter to reject the application-specific integrated circuit 

(ASIC) noise at 50 Hz or 60 Hz. 
Measurement values are filtered internally with a 50 Hz or 60 Hz filter to 
suppress EMC disturbance by that frequency. Use this parameter to set the 
filter in accordance to your country's power supply system frequency.

■ Body temperature unit: Unit selector. 
Select in which unit the device temperature for the cold junction 
compensation is displayed. 
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■ PROFIBUS Ident Number: PROFIBUS ident number selector. Select 
whether the manufacturer-specific or the profile-specific ident number is 
used. Select the ident number setting: 

• Manufacturer-specific
• Profile-specific
• Automatic

For details, see chapter 3.5

4.1.2 Device Tab "Diagnostics"

Figure 4.8 Tab device diagnostics (offline)

In the DTM, the tab "Diagnostics" enables you to configure the diagnostic 
behavior of the device both online and offline.

Note!
Changing the PROFIBUS Ident Number in the Online Mode
If you use the menu command in online parameterization, a change of ident 
number selection takes immediate effect. The device is automatically rebooted 
with the ident number selected.
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The tab "Diagnostics" contains the following parameters:
Section "Settings":

■ Condensed Status: Mode selector to be configured for status and 
diagnostic behavior.
Keep "Condensed diagnosis" or select "Classic diagnosis". 

As a part of the condensed mode in the DTM, the following settings determine the 
reaction of the device on manufacturer-specific diagnostic events. For each error 
type you can determine how to diagnose it and determine the status that the 
process value issues in case of the diagnosis:

Note!
Diagnostic Type for Cyclic Communication
Setting the diagnostic type to classic or condensed status in the tab Device 
determines the diagnostic type of the cyclic communication between the device 
and the DTM.

Error Type Diagnosis

Status that the process 
value issues if the 
assigned diagnosis is 
active:

Hardware error: Diagnosis: 
■ None
■ Maintenance
■ Maintenance demand
■ Maintenance alarm
■ Invalid process condition
■ Function check

Status: 
■ GOOD - OK
■ GOOD - Maintenance 

required
■ GOOD - Maintenance 

demanded
■ UNCERTAIN - 

Maintenance demanded
■ BAD - Maintenance 

alarm
■ UNCERTAIN - Process-

related, no maintenance
■ BAD - Process-related, 

no maintenance
■ BAD - Function check, 

local override
■ GOOD - Function check

Memory error: 
Body temperature too 
low: .
Body temperature too 
low: 
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Diagnostic parameters in the online mode
The following diagnostic information is displayed additionally in the online mode in 
order to diagnose issues or failures in real-time as they occur. 

4.2 Channel-Specific Characteristics
The following sections describe how to configure the channel-specific 
characteristics.

Figure 4.9 Signal measurement dataflow
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Figure 4.10 Analog input function block

4.2.1 Tab "General"

Figure 4.11 Tab channel
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The tab "General" contains the following parameters:
Section "Information": 

■ Tag: Tag assignment option.
Free text field, assign a unique tag to each of the 8 channels of the 
Temperature Multi-Input in the plant or process.

■ Strategy: Code assignment option. 
Free value field, assign a user-specific code value to each of the 8 
channels of the Temperature Multi-Input. This code can be used for 
classifying and summarizing information, e. g., for diagnosis reports. 

■ Alert key: Code assignment option.
Free value field, assign a user-specific code value to each of the 8 
channels of the Temperature Multi-Input. This code can be used for 
classifying and summarizing alarm messages and events, i. e., for quick 
localization. 

Channel information parameters in the online mode
The following parameter contains read-only information displayed in the online 
mode.

■ Static revision:Incremental modification counter for counting each 
modification of a parameter to document the status of parameterization 
modification.
This parameter counts changes in the online tabs General, Configuration, 
Alarm/Failsafe.

Section "Batch": 
■ Batch ID: Identification assignment option.

Free value field, assign an identifier for a batch process with distributed 
fieldbus systems to enhance process identification.

■ Unit
Free value field, assign an identifier for a batch unit with distributed fieldbus 
systems to enhance process identification. 

■ Operation
Free value field, assign an identifier for a batch operation with distributed 
fieldbus systems to enhance process identification. 

■ Phase
Free value field, assign an identifier for a phase with distributed fieldbus 
systems to enhance process identification. 
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4.2.2 Tab "Configuration"
The tab "Configuration" contains the following parameters:

Figure 4.12 Tab configuration

■ Target mode: Mode selection option per channel. 
Choose the target mode of the output value for each of the 8 channels. The 
following modes are available: 

• Auto: Automatic.
The measured value of the device is used as output value.

• Manual
Option to set the output value of the device manually.

• Out of service
The channel is not in use and the output value is BAD.

Channel information parameters in the online mode
The following parameters contain read-only information displayed in the online 
mode.

■ Actual mode
Current mode of the channel. The mode can differ from the "Target mode". 
Example: Different mode is selected but the selection is not confirmed yet. 
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Sections "Process value" and "OUT"
Use the sections "Process value" and "OUT" to scale the input (range) process 
values according to the requirements of your application and scale them to the 
required output range.

Section "Process value": 
■ Scale 0 %: Input scaling option for the minimum process value. 

Scale the input process value or value range according to your automation 
requirements. 

■ Scale 100 %:  Input scaling option for the maximum process value.
Scale the input process value or value range according to your automation 
requirements. 

■ PV filter time: Filter time setting option.
Determine the time in seconds (s) that the filter of the 1st degree needs to 
filter the measured value. 
This parameter can be applied to the process value independently of the 
scaling options.

Section "OUT": 
■ Scale 0 %: Output scaling option for the minimum process value/value 

range. 
Scale the output process value or value range according to your 
automation requirements. 

■ Scale 100 %:  Output scaling option for the maximum process value/value 
range.
Scale the output process value or value range according to your 
automation requirements. 

■ Unit: Unit selector.
Select the unit of the output range.

■ Decimal places: Value field option.
Determine the number of decimal places for the output value display.

■ OUT unit text: Free text field option. 
If you set the parameter Unit to "Textual unit definition", you can enter a unit 
for the measured value in the text field.

Note!
Adapt Process Value Scales after Changing Process Value Unit
When changing the process value unit in the dialog Measurement, the device 
automatically changes the scale values you set to keep OUT identical. 
Remember to adapt the process value scale settings according to your 
requirements after changing the process value unit. 
To use the physically measured value as out, set both the OUT and the process 
value scales to "0" and to "100".
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4.2.3 Tab "Alarm and Failsafe"

Figure 4.13 Tab alarm/failsafe

The tab "Alarm and Failsafe" contains the following parameters:
Section "Failsafe":

■ Failsafe type: Selector for the behavior in case of faults. 
For information on the behavior of the diagnostic status information in the 
classic mode, See chapter 5.1. Define how the device reacts in case of 
faults:

• Use failsafe value as OUT:
The output value is substituted by the failsafe value. This value is 
displayed in OUT. 

• Use last valid OUT value:
The last valid output value is used. This value is displayed in OUT. 

• Keep (wrong calculated) OUT value:
The last wrong value is used for all subsequent calculations.

■ Failsafe value: Free value field.
If you selected "Use failsafe value as OUT", use this field to enter a failsafe 
value in case of faults. 
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Section "Alarm limits":
■ HI HI Alarm Limit: Upper value limit setting for alarms.

Determine the upper limit of the OUT value that triggers a HI HI alarm.
■ HI Warning Limit: Upper value limit setting for prewarning alarms.

Determine the upper limit of the OUT value that triggers a HI warning alarm.
■ LO Warning Limit: Lower value limit setting for prewarning alarms.

Determine the lower limit of the OUT value that triggers a LO warning 
alarm.

■ LO LO Alarm Limit: Lower value limit setting for alarms.
Determine the lower limit of the OUT value that triggers a LO LO alarm.

■ Hysteresis: Hysteresis value setting for all upper and lower warning and 
alarm limit values.
Determine how long the measured value lies within the range of the defined 
alarm limit (hysteresis). The alarm remains activated until the value has left 
this range.

4.2.4 Tab "Measurement"

Figure 4.14 Tab measurement
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The tab "Measurement" contains the following parameters:
Channel parameters in the online mode
The following parameters contain read-only information displayed in the online 
mode.

■ Static revision:Incremental modification counter for counting each 
modification of a parameter to document the status of parameterization 
modification.
This parameter counts changes in the online tab Measurement.

■ Process value: The measured value and status of the sensor, as it is 
available for the function block.

■ Lower sensor limit: Physical lower limit function of the sensor and input 
range.

■ Upper sensor limit: Physical upper limit function of the sensor and input 
range.

Section "Sensor": 
■ Sensor type: Selector for the valid types of sensors for this device.

Select the valid sensor type for your application.
For more information on the sensor types, see data sheet.

■ Process value unit: Unit selector.
Select the unit for the value output: K, °C, °F, R°

■ Bias: Known offset setting option.
Free value field, add a known offset value to the currently measured value.

Section "Sensor Connection": 
■ Sensor connection: Sensor connection type selector. 

If the "Sensor type" is a resistance thermometer (RTD) or resistance range 
(R), you can use this parameter in order to determine the type of sensor 
connection.
Define if the sensor connection is 2-,3- or 4-wire. 

■ Sensor wire compensation: Compensation value option. If the "Sensor 
type" is a resistance thermometer (RTD) or resistance range (R) and the 
"Sensor Connection" is set to 2-wire, you can use this parameter in order to 
compensate the measured value. 
Enter a value in Ohm to be subtracted from the measured value.

Note!
Adapt Process Value Scales after Changing Process Value Unit
When changing the process value unit in the dialog Measurement, the device 
automatically changes the scale values you set to keep OUT identical. 
Remember to adapt the process value scale settings according to your 
requirements after changing the process value unit. 
To use the physically measured value as out, set both the OUT and the process 
value scales to "0" and to "100".
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■ Sensor wire check: Deactivation option for lead breakage and short 
circuit current detection.
You can Enable/Disable lead breakage and short circuit current detection 
for the sensor connection. 

Section "Cold Junction Compensation": 
■ Cold junction compensation: Selector for the type of cold junction 

compensation (CJC). 
If the "Sensor type" is a thermocouple (TC), you can determine if CJC is 
External/Internal. 

• Internal: Reference junction temperature is measured by the device 
itself via an internal sensor. 

• External: "External CJC reference" is used for compensation.
■ External CJC reference: Temperature setting option for CJC. 

If the "Sensor type" is thermocouple (TC) and the "Cold junction 
compensation" is set to "External", you can determine a fixed temperature 
for CJC.
Set a fixed temperature for the external cold junction compensation based 
on an external reference junction.

4.2.5 Channel Tab "Diagnostics"

Figure 4.15 Tab channel diagnosis
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In the DTM, the tab "Diagnostics" for each channel enables you to configure the 
diagnostic behavior of each channel.
The tab "Diagnostics" contains the following parameters:
Section "Settings":
The following settings determine the reaction of the device on channel-specific 
diagnostic events. For each error type you can determine how to diagnose it and 
determine the status that the process value issues in case of the diagnosis:

Error Type Diagnosis:

Status that the process 
value issues if the 
assigned diagnosis is 
active:

Channel disabled: Diagnosis: 
■ None
■ Maintenance
■ Maintenance demand
■ Maintenance alarm
■ Invalid process condition
■ Function check

Status: 
■ GOOD - OK
■ GOOD - Maintenance 

required
■ GOOD - Maintenance 

demanded
■ UNCERTAIN - 

Maintenance demanded
■ BAD - Maintenance 

alarm
■ UNCERTAIN - Process-

related, no maintenance
■ BAD - Process-related, 

no maintenance
■ BAD - Function check, 

local override
■ GOOD - Function check

Sensor connection 
error: 
Sensor range error: .
Body temperature too 
low: 
Body temperature too 
high: 
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Diagnostic parameters in the online mode
The following diagnostic information is displayed additionally in the online mode in 
order to diagnose issues or failures in real-time as they occur. 
NE107 diagnostic information icons are displayed for: 

■ Lead breakage
■ Short circuit current
■ Temperature overrange
■ Temperature underrange

NE107 diagnosis information icons are not displayed for sensor range errors and 
sensor connection errors.

NAMUR NE107 
Icon Diagnosis information

Good:
No failure
Maintenance required:
Maintenance demanded, Maintenance
Out of specification:
Invalid process condition

Function check:
Function check
Failure:
Maintenance alarm

Passivated: 
Is shown if no sensor type is selected. 
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4.3 Diagnosis

The DTM dialog diagnosis enables you to identify errors as efficiently as possible. 
Diagnosis displays the NAMUR icon for the device and each channel, as well as a 
list of active faults. The condensed status of the device can be configured via 
Device > Diagnostics. For more information, see chapter 4.1.2 and see chapter 
4.2.5.

Note!
*D0-TI-Ex8.PA.* DTM Diagnostic Information
The *D0-TI-Ex8.PA.* DTM always displays diagnostic information in condensed 
mode, independent of which diagnosis type has been chosen and is used for 
cyclic communication.
If you use the classic mode in the DTM, the OUT status contains the classic 
diagnosis information. Other than that, the DTM information looks identical.
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4.4 Simulation

Figure 4.16 Tab simulation with target mode set to auto.

The DTM menu "Simulation" offers the option to simulate the operation of the 
Temperature Multi-Input Device with different simulate values, e. g., to check 
whether the settings work for the whole process automation setup. 

Prerequisite: Enable Simulation: In the menu toolbar of PACTwareTM, go to 
Device > Simulation.
In the DTM, the tab "Simulation" for each channel enables you to simulate the 
following settings: 

■ Modify the target mode for each channel.
■ If you set the target mode to "Manual": Edit the OUT value and simulate a 

variety of situations.
■ If you set the target mode to "Auto": Edit a simulated process value and 

simulate a variety of situations. Can be used to check the failsafe and 
scaling behavior.
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The tab "Simulation" contains the following parameters:
Section "Target Mode":

■ Target mode: Selector for the simulation mode of the channel
Choose either of the following modes for simulation: 

• Auto: Select this mode to simulate the process value.
• Manual: Select this mode to set the OUT value and status. 
• Out of service: Select this mode to simulate the process with this 

channel as out of service. 
■ Actual mode: Current mode of the channel. The mode can differ from the 

"Target mode". 
Example: Different mode is selected but the selection is not confirmed yet. 

Section "OUT":
Prerequisite: As target mode, select "Manual".

■ OUT: Free value field for out value.
Enter an OUT value to simulate the behavior of the channel with it.

■ Quality: Selector to classify the OUT value. 
Classify the OUT value.

■ Limits: Selector to determine the limit of the simulation OUT value.
Select the property of the simulation value.The following options are 
available: 

• Not limited
• Low limited
• High limited
• Constant

Section "Simulated Process Value":
Prerequisite: As target mode, select "Auto".

■ Simulation enabled: Checkbox for activation of the process value 
simulation
Activate the checkbox to enable simulation of the process value. If the 
checkbox is deactivated, the auto mode keeps the channel in the last used 
mode.

■ Value: Free value field for process value. 
With simulation enabled, you can enter any value for simulation.

■ Status: Selector to classify the process value. 
Assign a status to the simulation process value.
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■ Limits: Selector to determine the limit of the simulation process value.
Select the property of the simulation value.The following options are 
available: 

• Not limited
• Low limited
• High limited
• Constant
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5 Bus Configuration for Cyclic Communication
Prerequisite: The GSD file is installed. If your FDT Frame supports Bus Master 
Configuration, you can also use the Channel Assignment dialog. For more 
information, see chapter 5.3. 
During cyclic data exchange, "user data" is exchanged at regular intervals 
between the master and the slave or bus, e. g., between a PCS and a field device. 
User data includes measurement values, limit position feedback, and output data, 
etc. The bus cycle time depends on the number of nodes and the amount of data 
that is transmitted.

5.1 Cyclic Data Transfer 
During cyclic data transfer, the device provides 8 x a measured value with status. 
The GSD file contains 2 module types that can be allocated to the slots 1 ... 8:

■ Analog Input short: AI (short)
■ Analog Input long: AI (long)

The transferred data is identical. The "long" type is written in extended format and 
contains the description of the data types included in the transferred data.
The transferred data is structured as follows: 
Analog values consist of data blocks of 5 bytes per block. 
The measured value is coded in the first 4 bytes as floating point figures in 
accordance with the standard IEEE 754. 
The 5th byte contains the status information of the measured value according to 
the PA Profile 3.02 specification. 
The status values of the classic mode and the condensed mode differ.
Status Values Common to Condensed and Classic Mode 
Independent of the classic mode or the condensed mode, the status can have the 
following values if no failures or issues have occurred:

■ GOOD – OK: Measured value is GOOD, no faults found 
■ Status is set for 10 s after a configuration parameter has been changed: 

GOOD – Update Event 
■ Status is set for 10 s after the simulation has been started:

UNCERTAIN – SIMULATE_START – LIMIT_CONST 
Classic Mode: Status Information in Case of Failure
In case of failure, for classic mode the following status information applies:

■ Failsafe Mode = Fail Safe Value:
UNCERTAIN – Substitute Value – Constant

■ Failsafe Mode = Last Usable Value:
UNCERTAIN – Last Usable – Constant
If no GOOD value has ever been measured after startup:
UNCERTAIN – Initial Value – Constant
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■ Failsafe Mode = Wrong Value:
Channel is deactivated, i. e., no sensor type is chosen or the device 
configuration is currently under change, thus temporarily disabling 
measurement: 
BAD – Non Specific – Constant
Device fault:
BAD – Device Failure – Constant
Lead breakage, short circuit current, underrange, overrange: 
BAD – Sensor Failure – Constant

BAD – OoS – The target mode is OoS

Condensed Mode: Status Information in Case of Failure
In case of failure, for condensed mode the following status information applies:

All other status values of the condensed mode are issued directly. 
For details, see chapter 4.1.2 and see chapter 4.2.5.

5.2 User Parameterization
With the User Parameterization the diagnostic mode can be selected.
Condensed status: Mode selector to be configured for status and diagnostic 
behavior.
Select "Condensed diagnosis" or keep "Classic diagnosis". 

State triggering 
failsafe 
mechanism Failsafe mode

Failsafe value Last usable value Wrong calculated 
value

BAD – 
maintenance alarm

UNCERTAIN – 
substitute set

UNCERTAIN – 
substitute set

BAD – 
maintenance alarm

BAD – process-
related

UNCERTAIN – 
process-related

UNCERTAIN – 
process-related

BAD – process-
related

BAD – function 
check

UNCERTAIN – 
substitute set

UNCERTAIN – 
substitute set

BAD – function 
check
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5.3 Channel Assignment

Figure 5.1 Tab channel assignment

The DTM menu "Channel Assignment" can be used to parameterize Bus Master 
Configuration settings for cyclic communication. 
The tab "Channel Assignment" contains the following parameters:
Section "General Settings":

■ Condensed status: Mode selector to be configured for status and 
diagnostic behavior.
Select "Condensed diagnosis" or keep "Classic diagnosis". 

Note!
Diagnostic Type for Cyclic Communication
Setting the diagnostic type to classic or condensed status in "Channel 
Assignment" determines the diagnostic type of cyclic communication between the 
device and the bus master.
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Section "Module Configuration":
■ Slot 1 ... 8: IO module selector for the channels 1 ... 8. 

To determine how the cyclic data transfer takes place, select either of the 
following options:

• No module
• AI (short)
• AI (long)

Section "Binary representation":
■ Slave Bus Parameter Set: Read-only information to check the diagnostic 

information that is set per byte.
5.4 Diagnosis in Cyclic Communication

The following types of diagnosis exist:
■ Classic diagnosis
■ Condensed diagnosis

Depending on the type of diagnosis, the following parameter lists apply for 
diagnosis information on the Temperature Multi-Input Device. 
Extension (Valid for both Diagnostic Modes)
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1 Device/
PHY_BLK

0 DIA_EXT_HW_ERR Is set if a device failure is 
detected. 

1 DIA_EXT_MEM_ERR Is set if EEPROM 
checksum verification 
fails.

2 DIA_EXT_BODY_
TEMP_HI

Device temperature 
exceeds specified 
temperature range.

3 DIA_EXT_BODY_
TEMP_LO

Device temperature falls 
below the specified 
temperature range.

4 ... 7 reserved
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2 Channel 1 8 DIA_EXT_C1_
DISABLED

No sensor selected.

9 reserved
10 DIA_EXT_C1_

SENSOR_C 
ONNECTION_ERR

Is set if one of the 
following sensor errors is 
detected:
■ LeadBreak
■ ShortCircuit

11 DIA_EXT_C1_
SENSOR_
R ANGE_ERR

Is set if one of the 
following sensor errors is 
detected:
■ Underrange
■ Overrange

Channel 2 12 ... 15 see Channel 1 see Channel 1
3 Channel 3 16 ... 19

Channel 4 20 ... 23
4 Channel 5 24 ... 27

Channel 6 28 ... 31
5 Channel 7 32 ... 35

Channel 8 36 ... 39
6 40 ... 47 reserved
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Classic Diagnosis Parameters
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1 0 DIA_HW_ELECTR yes Is set if a device failure is 
detected.

1 3 DIA_TEMP_ELECTR Electronic temperature too 
high. See respective 
extension bits.

1...3 not used Fixed to 0.
4 DIA_MEM_CHECKSUM yes Is set if a MemoryError is 

detected.
5...7 not used Fixed to 0.

2 0...1 not used Fixed to 0.
2 not used Fixed to 0.
5 DIA_MAINTENANCE yes Is set if any of the following 

bits is set: 
■ DIA_EXT_Cx_SENSOR_

CO NNECTION_ERR
■ DIA_EXT_Cx_SENSOR_

RA NGE_ERR
6 not used Fixed to 0.

3 0...7 reserved Fixed to 0.
4 0...6 reserved Fixed to 0.

7 EXTENSION_AVAILABLE no More diagnosis information 
available.
65



Temperature Multi-Input Device
Bus Configuration for Cyclic Communication
 20
13

-1
1

Condensed Diagnosis Parameters
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1 0...7 reserved yes Fixed to 0.
2 0...2 reserved Fixed to 0.

5 DIA_MAINTENANCE no Can be configured by the 
DTM. For more information, 
see chapter 4.1.2 and see 
chapter 4.2.5.

6 reserved Fixed to 0.
3 0 DIA_MAINTENANCE_ALAR

M
yes Can be configured by the 

DTM. For more information, 
see chapter 4.1.2 and see 
chapter 4.2.5.

1 DIA_MAINTENANCE_DEM
ANDED

no an be configured by the 
DTM. For more information, 
see chapter 4.1.2 and see 
chapter 4.2.5.

2 DIA_FUNCTION_CHECK no Can be configured by the 
DTM. For more information, 
see chapter 4.1.2 and see 
chapter 4.2.5.

3 DIA_INV_PRO_COND no Can be configured by the 
DTM. For more information, 
see chapter 4.1.2 and see 
chapter 4.2.5.

4...7 reserved Fixed to 0.
4 0...6 reserved Fixed to 0.

7 EXTENSION_AVAILABLE no More diagnosis information 
available.
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6 Troubleshooting and Diagnosis

1. Sensor-specific red LEDs: Indicate the status of the related sensor input 
channels 

2. Red LED COM ERR: Indicates the communication status
3. Green LED PWR: Indicates the status of the bus power

LED Indications

LED Status and Error Indication

LED Statuses Cause Remedy
PWR 
(green)

OFF No power supply ■ Check power supply
■ Check fieldbus cable 

wiring
Permanently 
ON 

Power available -

COM 
(red)

OFF Cyclic communication 
active

-

Permanently 
ON

Hardware error Send device to 
Pepperl+Fuchs for repair

Flashing 
ON/OFF

No communication
Communication errors

■ Check DP Master
■ Check Segment Coupler
■ Check wiring

Sensor 
(red)
Channel 
1–8

OFF No sensor errors 
detected

-

Flashing 
ON/OFF

Sensor error (over / 
under range, wiring 
error, lead breakage)

Check sensor wiring. Check 
diagnostic messages in the 
DTM.

1 2 3
67



Temperature Multi-Input Device
Troubleshooting and Diagnosis
 20
13

-1
1

Common Parameters for Both Diagnosis Types

Classic Diagnosis Parameters

Problem Solution  
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DIA_EXT_
HW_ERR

Body 
temperature 
is out of 
spec.

Is set if a 
DEVICE_
FAILURE is 
detected.

Send the device to 
Pepperl+Fuchs

DIA_EXT_
MEM_ERR

Is set if 
EEPROM 
checksum 
verification 
fails.

Reconfigure and then 
restart the device. If 
the problem persists, 
send the device to 
Pepperl+Fuchs 

DIA_EXT_
BODY_
TEMP_HI

Operate the device 
within the 
specification.

DIA_EXT_
BODY_
TEMP_LO

Operate the device 
within the 
specification.

DIA_EXT_C1_
DISABLED

No sensor 
selected. 

Channel 
1 ... 8

Type: Classic 
diagnosis 

If a sensor should be 
used, select the 
correct sensor type in 
the DTM.

DIA_EXT_C1_
SENSOR_
CONNECTION
_ERR

■ LeadBreak
■ ShortCircuit

Channel 
1 ... 8

Is set if one of 
the sensor 
errors is 
detected.

Check the wiring.

DIA_EXT_C1_
SENSOR_
RANGE_ERR

■ Underrange
■ Overrange

Channel 
1 ... 8

Is set if one of 
the sensor 
errors is 
detected.

■ Check the wiring.
■ Check if the 

measurement 
range of the sensor 
is valid for your 
application.

Problem Solution
Parameter Description Remedy
DIA_HW_ELECTR Is set if a DeviceError is detected. 

DIA_EXT_HW_ERR is set.
Send the device 
to Pepperl+Fuchs

DIA_MEM_CHECKSUM Is set if a MemoryError is detected. 
DIA_EXT_MEM_ERR is set.

Operate the 
device within the 
specification.
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Condensed Diagnosis Parameters

DIA_MAINTENANCE Is set if either of the following bits is 
set:
DIA_EXT_Cx_SENSOR_
CONNECTION_ERR

Check the sensor 
wiring.

DIA_EXT_Cx_SENSOR_RANGE_
ERR

Check if the 
sensor supports 
the required 
measurement 
range.
Check the wiring.

Problem Solution
Parameter Message Cause Remedy
DIA_MAINTENANCE Maintenance DIAG_EVENT_

SWITCH
 is set in the DTM

Depends on the status 
that the process value 
issues. For more 
information, see chapter 
4.1.2 and see chapter 
4.2.5.

DIA_MAINTENANCE
_ALARM

Maintenance 
alarm

DIAG_EVENT_
SWITCH 
is set in the DTM

Depends on the status 
that the process value 
issues.  For more 
information, see chapter 
4.1.2 and see chapter 
4.2.5.

DIA_MAINTENANCE
_DEMANDED

Maintenance 
demand

DIAG_EVENT_
SWITCH
 is set in the DTM

Depends on the status 
that the process value 
issues.  For more 
information, see chapter 
4.1.2 and see chapter 
4.2.5.

DIA_FUNCTION_
CHECK

Function 
check

DIAG_EVENT_
SWITCH 
is set in the DTM

Depends on the status 
that the process value 
issues. For more 
information, see chapter 
4.1.2 and see chapter 
4.2.5.

DIA_INV_PRO_
COND

Invalid 
process 
condition

DIAG_EVENT_
SWITCH 
is set in the DTM

Depends on the status 
that the process value 
issues.  For more 
information, see chapter 
4.1.2 and see chapter 
4.2.5.

Problem Solution
Parameter Description Remedy
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7 Reference List of Parameters
In this section you find a list of all parameters used in the DTM. The characteristics 
are marked as follows: 

■ *F = Function parameter. Parameter is essential for operation and must be 
correctly set.

■ I = Information parameter. Parameter is used for device description or 
documentation.

■ D = Diagnosis parameter. Parameter is used for additional device and 
diagnosis functions: Essential for troubleshooting, prevention, and 
enquiries with Pepperl+Fuchs. 

■ m = Parameter can be modified.
Value Range for DIAG_EVENT_SWITCH Parameters
The DTM uses DIAG_EVENT_SWITCHES to mark the defined diagnostic states. 
These parameters always have the following possible values. The values are valid 
for all instances where the DIAG_EVENT_SWITCHES are used. 

Device-related parameters

Diagnosis Status
■ None
■ Maintenance
■ Maintenance demand
■ Maintenance alarm
■ Invalid process condition
■ Function check

■ GOOD – OK
■ GOOD – Maintenance required
■ GOOD – Maintenance demanded
■ UNCERTAIN – Maintenance demanded
■ BAD – Maintenance alarm
■ UNCERTAIN – Process-related, no 

maintenance
■ BAD – Process-related, no maintenance
■ BAD – Function check, local override
■ GOOD – Function check
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F, m Activate Write Lock
WRITE_LOCKING

Activates/deactivates the 
read-only function by 
software.

not write-protected,
write-protected

D Write Lock Active
HW_WRITE_
PROTECTION

Information banner 
signaling that the write 
protection is enabled. 
The banner includes the 
option Unlock device.

not write-protected, 
write-protected

m Reset to factory 
defaults
FACTORY_RESET

Resets the device 
information to the factory 
default.

0 ... 65535
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I, m Tag 
TAG_DESC

Unique description of the 
device in the plant or 
process.

(32 characters)

D Device ID Manufacturer specific 
identification of the device. 

(16 characters)

D Manufacturer
MANUFACTURER

Read-only identification of 
the manufacturer of the 
device.

0 ... 65535 
93 (Pepperl+Fuchs)

I Static revision
ST_REV

Incremental modification 
counter for counting each 
modification of a parameter. 
Documents the status of 
modification of 
parameterization. 
ST_REV counts all changes 
in the online tab Device 
Information. 

0 ... 65535

D Software revision
SOFTWARE_
REVISION

Version number of the 
device firmware. Required 
for enquiries to 
Pepperl+Fuchs.

(16 characters)

D Hardware revision
HARDWARE_
REVISION

Version number of the 
device hardware. Required 
for enquiries to 
Pepperl+Fuchs.

(16 characters)

D Serial number
DEVICE_SER_
NUM

Serial number of the device. 
Required for enquiries to 
Pepperl+Fuchs.

(16 characters)

I, m Strategy 
STRATEGY

Free value field for user-
specified configuration of a 
code key for sorting or 
summarizing diagnostic 
information. 

0 ... 65535

I, m Alert key
ALERT_KEY

User-specified value for 
sorting alarms or events. 
The value can contain the 
identification number of the 
plant unit. It helps to identify 
the location (plant unit) of an 
event.

0 ...255

I, m Description
DESCRIPTOR

User-specified description 
of the device as a 
measuring point in the 
application.

(32 characters)

I, m Message 
DEVICE_
MESSAGE

User-specified additional 
description of the device in 
the application or plant.

(32 characters)

I, m Installation date 
DEVICE_
INSTAL_DATE

User-specified entry of the 
installation date of the 
device in the plant.

(16 characters)
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F, m ASIC rejection 
ASIC_
REJECTION

User- and country-specific 
filter to reject the 
application-specific 
integrated circuit (ASIC) 
noise. 
Measurement values are 
filtered internally with a 
50 Hz or 60 Hz filter to 
suppress EMC disturbance 
by that frequency. 

50 Hz
60 Hz

F, m Body temperature 
unit 
BODY_TEMP_
UNIT

Unit selector for the device 
temperature of the cold 
junction compensation.

K
°F
°C
°R

F, m PROFIBUS Ident 
Number
IDENT_
NUMBER_
SELECTOR

PROFIBUS Ident number 
selector. See chapter 3.5

Profile specific (0),
Manufacturer specific (1)
Automatic

D, m Condensed Status
COND_STATUS_
DIAG

Mode selector for status 
information and diagnostic 
behavior. 

Condensed diagnosis
Classic diagnosis

D, m Hardware error
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of a hardware error of the 
device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis: 
Maintenance alarm
Status: 
BAD - Maintenance 
alarm

D, m Memory error
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of a memory error of the 
device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis: 
Maintenance alarm
Status: 
BAD - Maintenance 
alarm

Ch
ar

ac
te

ris
tic

s*

Pa
ra

m
ete

r/
Mn

em
on

ic

De
fin

iti
on

Va
lue

 ra
ng

e 
bo

ld
 = 

de
fau

lt
72



Temperature Multi-Input Device
Reference List of Parameters

 20
13

-1
1

Channel-related parameters

D, m Body temperature 
too low
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of a body temperature too 
low error of the device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis: 
Maintenance alarm
Status: 
GOOD - Maintenance 
required

D, m Body temperature 
too high
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of a body temperature too 
high error of the device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis: 
Maintenance alarm
Status: 
GOOD - Maintenance 
required
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I, m Tag 
TAG_DESC

User-specific unique 
description of each of the 8 
channels of the 
Temperature Multi-Input in 
the plant or process.

(32 characters)

I, m Strategy
STRATEGY

Free value field for user-
specified configuration of a 
code key for sorting or 
summarizing diagnostic 
information. 

0 ... 65535

I, m Alert key
ALERT_KEY

User-specified value for 
sorting alarms or events. 
The value can contain the 
identification number of the 
plant unit. It helps to identify 
the location (plant unit) of an 
event.

0 ...255

Ch
ar

ac
te

ris
tic

s*

Pa
ra

m
ete

r/
Mn

em
on

ic

De
fin

iti
on

Va
lue

 ra
ng

e 
bo

ld
 = 

de
fau

lt
73



Temperature Multi-Input Device
Reference List of Parameters
 20
13

-1
1

I Static revision
ST_REV

Incremental modification 
counter for counting each 
modification of a parameter. 
Documents the status of 
modification of 
parameterization.
For channel-related 
parameters, 2 static revision 
counters are used:  
1. ST_REV to count chang-

es in the online tabs Gen-
eral, Configuration, 
Alarm/Failsafe

2. ST_REV to count chang-
es in the online tab Mea-
surement.

0 ... 65535

I, m Batch ID
BATCH

Free value field for a batch 
process identifier with 
distributed fieldbus systems 
to enhance process 
identification.

0 ... 4.294.967.295

I, m Unit Free value field for a unit 
identifier with distributed 
fieldbus systems to 
enhance process 
identification.

0 ... 65535

I, m Operation Free value field for an 
identifier of the current 
operation with distributed 
fieldbus systems to 
enhance process 
identification.

0 ... 65535

I, m Phase Free value field for an 
identifier of the current 
process with distributed 
fieldbus systems to 
enhance process 
identification.

0 ... 65535

F, m Target mode
TARGET_MODE

Mode selector of the output 
value for each of the 
8 channels.

Auto
Manual
Out of service

I Actual mode
MODE_BLK

Current mode of the 
channel. The mode can 
differ from the "Target 
mode" if operating 
conditions prevent the 
sensor to work in the "Target 
mode" defined.

F, m Process value:
Scale 0 %
PV_SCALE

Scaling option for minimum 
process value.

0
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F, m Process value:
Scale 100 %
PV_SCALE

Scaling option for maximum 
process value.

100

F, m PV filter time
PV_FTIME

Filter time of the first degree 
for filtering the measured 
value.

0

F, m Process 
value OUT:
Scale 0 %
OUT_SCALE

Scaling option for minimum 
process output value/range.

0

F, m Process 
value OUT:
Scale 100 %
OUT_SCALE

Scaling option for maximum 
process output value/range.

100

F, m Process 
value OUT:
Unit
OUT_SCALE_
UNIT

Unit selector for output 
range.

C°

F, m Process 
value OUT:
Decimal places

Free value field for 
determining the number of 
decimal places for the 
output range.

2

F, m Process 
value OUT:
OUT unit text
OUT_UNIT_TEXT

Free-text field for a 
user.specified unit for the 
output range.

F, m Failsafe type
FSAFE_TYPE

Selector for the behavior of 
the sensor in case of faults.

Use failsafe value as 
OUT
Use last valid OUT 
value
Keep (wrong calculated) 
OUT value

F, m Failsafe value
FSAFE_VALUE

Free value field for a user-
specified value in the case 
of fault.

0

F, m HI HI Alarm Limit
HI_HI_LIM

Upper value limit setting for 
alarms.

INF

F, m HI Warning Limit
HI_LIM

Upper value limit setting for 
prewarning alarms.

INF

F, m LO Warning Limit
LO_LIM

Lower value limit setting for 
prewarning alarms.

-INF

F, m LO LO Alarm Limit
LO_LO_LIM

Lower value limit setting for 
alarms.

-INF

F, m Hysteresis
ALARM_HYS

User-specified alarm limit 
range for all upper and lower 
warning and alarm limit 
values.

0,5
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I Process value
PRIMARY_VALUE

Measured value and status 
of the sensor.

850°

I Lower sensor limit
LOWER_SENSO
R_LIMIT

Physical lower limit function 
of the sensor and input 
range.

-200°

I Upper sensor limit
UPPER_SENSOR
_LIMIT

Physical upper limit function 
of the sensor and input 
range.

850°

F, m Sensor type
LIN_TYPE

Selector for the valid types 
of sensors for this device.

No Sensor 
PT50 (IEC)
PT100 (IEC)
PT200 (IEC)
PT500 (IEC)
PT1000 (IEC)
PT100 (JIS) 
Ni100 (DIN) 
Cu10 
TC B 
TC E 
TC J 
TC K 
TC N 
TC R 
TC S 
TC T 
NI120 MINCO 
NI200 DIN 
TC W5RE26 
-150... 150 mV 
0 ... 650 Ohm 
0 ... 1300 Ohm 
0 ... 2600 Ohm 
0 ... 5200 Ohm 

F, m Process value unit
PRIMARY_VALUE
_UNIT

Unit selector for the value 
output.

K 
°C
°F 
°R

F, m Bias
BIAS_1

Free value field for a user-
specified offset setting.

0

F, m Sensor connection
SENSOR_CONN
ECTION

Selector for sensor 
connection type if sensor 
type is resistance 
measurement.

2 wires
3 wires
4 wires

F, m Sensor wire 
compensation
COMP_WIRE1

Free value field for 
measurement 
compensation if sensor type 
is resistance measurement 
and sensor connection is 2-
wire.

0

F, m Sensor wire check
SENSOR_WIRE_
CHECK_1

Deactivation option for lead 
breakage and short circuit 
current limitation.

Enabled
Disabled
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F, m Cold junction 
compensation
RJ_TYPE

Selector for the type of cold 
junction compensation 
(CJC).

Internal
External

F, m External CJC 
reference
EXTERNAL_
RJ_VALUE

Free value field for user-
specified CJC temperature 
if sensor type is 
thermocouple and cold 
junction compensation is 
external.

0

D, m Channel disabled
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of a channel disabled error 
of the device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis:  None
Status: BAD - 
Maintenance alarm

D, m Sensor connection 
error
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of a sensor connection error 
of the device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis:  
Maintenance alarm
Status: 
BAD - Maintenance 
alarm

D, m Sensor range error
DIAG_EVENT_
SWITCH

Combined diagnostic 
treatment and status 
information selector in case 
of sensor range error of the 
device.

See "Value Range for 
DIAG_EVENT_SWITCH 
Parameters" on page 70
Diagnosis:  
Maintenance alarm
Status: 
BAD - Maintenance 
alarm

Ch
ar

ac
te

ris
tic

s*

Pa
ra

m
ete

r
Mn

em
on

ic

De
fin

iti
on

Va
lue

 ra
ng

e 
bo

ld
 = 

de
fau

lt
77



Subject to modifications
Copyright PEPPERL+FUCHS  •  Printed in Germany

www.pepperl-fuchs.com

 PROCESS AUTOMATION – 
PROTECTING YOUR PROCESS

Worldwide Headquarters
Pepperl+Fuchs GmbH
68307 Mannheim · Germany
Tel. +49 621 776-0
E-mail: info@de.pepperl-fuchs.com

For the Pepperl+Fuchs representative 
closest to you check www.pepperl-fuchs.com/contact

TDOCT-3545_ENG
11/2013


	1 Safety
	1.1 Validity
	1.2 Symbols used
	1.3 System Operator and Personnel
	1.4 Pertinent Laws, Standards, Directives, and further Documentation
	1.5 Marking
	1.6 Intended Use
	1.7 Improper Use
	1.8 Mounting and Installation
	1.8.1 Hazardous Area
	1.8.2 Instructions for Zone 1
	1.8.3 Instructions for Zone 2 and Safe Areas

	1.9 Repair and Maintenance
	1.10 Delivery, Transport and Storage
	1.11 Disposal

	2 Product Specifications
	2.1 Overview and Application
	2.2 Component Identity
	2.3 Technical Data

	3 Installation and Commissioning
	3.1 Mounting and Dismounting
	3.1.1 Using the Separation Wall

	3.2 Hardware Installation
	3.2.1 Temperature Multi-Input Device Cable and Connection Information
	3.2.2 F2D0-TI-Ex8.* Housing: Ensuring the Degree of Protection
	3.2.3 Grounding and Shielding
	3.2.4 Electrical Connection
	3.2.5 Dip Switch Settings

	3.3 Write Protection Settings
	3.4 Address Settings
	3.5 PROFIBUS Ident Number Setting
	3.6 Requirements for Commissioning
	3.7 Parameterization and Configuration Procedure
	3.8 DTM Software Installation and Commissioning
	3.9 DTM Dialogs
	3.9.1 Online Dialogs
	3.9.2 Offline Dialogs
	3.9.3 DTM User Interface
	3.9.4 DTM Structural Diagram


	4 Device Parameterization
	4.1 Device-Specific Parameters
	4.1.1 Tab "Device Information"
	4.1.2 Device Tab "Diagnostics"

	4.2 Channel-Specific Characteristics
	4.2.1 Tab "General"
	4.2.2 Tab "Configuration"
	4.2.3 Tab "Alarm and Failsafe"
	4.2.4 Tab "Measurement"
	4.2.5 Channel Tab "Diagnostics"

	4.3 Diagnosis
	4.4 Simulation

	5 Bus Configuration for Cyclic Communication
	5.1 Cyclic Data Transfer
	5.2 User Parameterization
	5.3 Channel Assignment
	5.4 Diagnosis in Cyclic Communication

	6 Troubleshooting and Diagnosis
	7 Reference List of Parameters

